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What is Entourage? 

Entourage is a Mac Office groupware package for Mac OS X that allows you to 
check e-mail, maintain a calendar, organize an address book, and much more. This 
handout will focus on the use of Entourage with a Microsoft Exchange Server, Version 
11, SP2. 
 
Setting Up Entourage Profiles 
 
 For instructions on setting up Entourage to access your Exchange account on the 
Austin Exchange Messaging Service (AEMS) please visit 
http://www.utexas.edu/its/messaging/answers/entourage2004.php.    
 
 You will need to follow the instructions at 
http://www.utexas.edu/its/messaging/answers/entourage_multiple.php if you are using 
Entourage to access more than one profile from the same workstation. 
 

Entourage Navigation And Terminology 
 

Entourage opens to display your e-mail messages with four main areas: 
Navigation buttons, Folder List, Message List and Preview Pane.  
 

 

Navigation 
Buttons 

Message 
List 

Folder 
List 

Preview 
Pane 
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Figure 1: Main Entourage E-mail Screen 

Navigation Buttons 
 

Click on any of the Navigation buttons to switch between Entourage features. 
 
 

 
Figure 2: Navigation Buttons 

Folder List 
 

Your Folder list is sorted into files found on your hard drive and files found on 
your e-mail server. If you have not saved any e-mail files to your hard drive, you may 
wish to collapse that part of the list by clicking on the down arrow next to Folders on My 
Computer.  That way, you can more  easily see the folders stored on the Exchange 
server. 
 

The e-mail files on your e-mail server are sorted into four default folders: Inbox, 
Sent Items, Deleted Items, and Junk E-Mail. Any additional folders you have on your e-
mail server will also appear. If you are on an Exchange server, you will also see a link to 
the Public Folders that are visible by all users on the server. 
 

 
Figure 3:  Folder List 
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To create additional folders choose File -> New -> Folder.  A dialogue will pop 
up allowing you to select where to place the folder.  To place the folder in the Inbox for 
instance, you will highlight the Inbox and then click on OK. 
 
 

 
Figure 4: Creating A New Folder 

 
 

Once a folder has been created, you can drag and drop messages into the folder 
from the Message List or create a Rule to automatically send messages to that folder as 
they are received.  Rules are discussed later in this document. 
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Message List 
 

The message list displays information from the e-mail message headers and can 
be sorted in many different ways. To sort by a field other than date, for instance, click the 
Arrange by drop down list and choose how you would like the messages to be sorted. 
You can also specify whether the messages should be sorted in ascending or descending 
order using the drop down menu to the right of the Arrange by menu, as well as display 
messages in groups. 
 

 
Figure 5:  Sorting Messages 

 
 

To delete a message using the Message List click once on the message to select it 
then click the delete button from the toolbar. You can also delete a message from the 
Message List by selecting the message and pressing the Delete key on your keyboard. 
Once you have deleted a message it will be moved to your Deleted Items folder on your 
e-mail server. To permanently delete a message you must also delete it from your 
Deleted Items folder. 
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Figure 6:  Mail Message 

 

Preview Pane 
 

To view a message in the Preview Pane click once on the message in the 
Message List. To open a message in a new window, double-click on the message in the 
Message List. 

 

Entourage Sending and Receiving E-mail 
Composing New Messages 
 

To compose a new message, click the New button in the main Entourage Mail 
toolbar. Also note the Reply, Reply All, and Forward buttons located in the toolbar. 
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Figure 7:  Creating A New Message 

 
 
 
 

A new mail window will pop up.  You will first type in the Address to send the e-
mail to by clicking within the To, Cc or Bcc fields.  You can either type in the e-mail 
address to send to, or you can select them off of the Address Book.  You can also type in 
a person’s or a group’s name, which if recognized, will resolve to an e-mail address.  
(See the Address Book section below on the mailing lists available to Entourage, 
including your own contacts and groups.) Then, you will click on the message itself and 
type in the subject and the message into the message entry area on the window.  When 
ready to send the message, click on Send Now. 
 
 

 
Figure 8:  Typing In E-mail Addresses 

E-mail Signature 
 

You can create your own e-mail signature to be included on all new messages 
when you select the signature tab.  Under Entourage Tools Signatures, you can create 
a New signature.  Click on New and type in your signature.  Then, close the window. You 
will then be prompted to Save or Don’t Save the signature.  When you compose your 
message, there is a signature icon that will provide you a list of signatures to choose 
from.   
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Figure 9: Creating E-mail Signatures 

 
Please note that signatures are not automatically included in Entourage e-mail.  You 

have to perform additional steps for this to happen. 
 

1. Go to Tools Accounts on the main Entourage menu 
2. Under Accounts, select the account to edit and then click on Edit Account. 
3. Select the signature that you want to use automatically as the default signature for 

new messages under Message Options.  The default signature is “none”. 
4. When done, click on the OK button (not shown). 

 

 
Figure 10:  Selecting a Default E-Mail Signature 
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Address Book 
 

Entourage in the Exchange environment provides access to several different 
Address Books from which you can obtain valid e-mail addresses for your organizations 

. 
• Personal Address Book (Stored Locally) 
• Contacts (on AEMS) 
• Global Address List  (from Exchange Server) 
• UT Austin LDAP directory 

 
This means that you have access to four different sources of E-mail address 

information, all of which are available when configured correctly for composing a 
message.   If Entourage is configured to work with AEMS, you will have access to the 
Global Address List and the Contacts list.  You will need to follow additional 
instructions to access the UT Austin LDAP server which can be found on the Answers 
page at http://www.utexas.edu/its/messaging/answers/index.php.  (Note:  You will have 
to select this address book from “Choose Address Book” before the LDAP directory 
entry will show up on your address book list as in Figure 11.) 

 
 

 
 

Figure 11:  Selecting Your Address Book When Composing a Message 
 
 

Normally, on AEMS, you will use Entourage Contacts to store contact 
information for your friends, family, and business associates.  Access the Contacts 
console in Entourage by clicking on the Address Book icon.  The Address Book 
window displays a list of contacts in the upper portion of the window and a preview pane 
in the lower portion. You can sort the list by clicking column headings, and you can 
double-click a row to open the details for a contact. The Address Book provides views, 
rather than folders, that allow you to see a specific subset of your list.    
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Figure 12:  Address Book Navigation 

Creating a Contact   
 

1. Click Address Book.   
2. Click New.   
3. In the Create Contact dialog box, 

enter the information you want for 
the contact.  

4. To save this contact and close the 
Create Contact dialog box, click 
Save & Close.   

5. To enter more information about this 
contact, click More and then enter 
any additional information you want 
and save the information entered. 

 
You can also update your Address 

book while entering in an e-mail address 
by using the sequence Tools Add To 
Address Book, typing the “Mac 
Symbol”= sequence next to the prior 
command or selecting CTRL Click and 
“Add To Address Book” when an e-mail 
address is highlighted.  
   

 

 

 

 
 
Figure 13:  Address Book Contact Creation 
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Creating a Group In Your Address Book 
 

You can create groups of contacts so that you can address an e-mail message to 
multiple people by group name.   
 

1. In the Address Book, click on  Address Book [On My Computer]  
 

 
 

Figure 14:  Creating a Local Contact Group 
 
and then click Add Group (top of the Address Book window).   
 

 
 

2. Name the group.  
3. Click in the list box to add e-mail addresses to the group.    
4. Click on the Save Group (diskette) icon.  

 

 
Figure 15:  E-Mail Group Creation 
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The group name will appear in your Address Book on your computer. To save 
this information in your Contacts folder, simply drag the addresses from your Address 
Book [On My Computer] to your Contacts folder on the AEMS server. 
 

Using the Address Book 
 

When composing a message you can easily retrieve addresses from your address 
book in two ways. When you begin typing in a name or address, Entourage will 
automatically suggest any matches from your address book or from previously entered e-
mail addresses that you may not have ever entered into the book.  (In the latter case, 
Entourage automatically stores e-mail addresses, whether or not they are valid.) If you 
see the address you are looking for, click on it with your mouse and it will be added to 
the field. 
 

You can also display your address book while composing a message by clicking 
on the Address Book icon when adding addresses to the To, CC, or BCC fields. The 
Address Book will appear on the right. Add addresses by clicking and dragging them 
into the appropriate field or by doubling clicking on an address. 
 

 
Figure 16:  Entourage Local Address Book 

 
 Please remember to select Contacts when using your address book stored on the 
server. If you need to communicate with someone not on your address book who is a 
member of the UT Austin community, select Default Global Address List or the 
Directory (LDAP). 
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Entourage Calendars 
Viewing the Calendar 
 

To view your Calendar, click Calendar in the navigation pane. Click on the 
Calendar that is associated with your Exchange account when you set up Entourage, not 
Calendar (On My Computer) in the Calendar view window.   
 

The Calendar is displayed in the Month view, or whichever view was last used. 
 

 
Figure 17: Typical Entourage Calendar 

 
You can view your calendar in increments of a day, a work week, a week, or a 

month by clicking on the appropriate button in the toolbar. You can also jump directly to 
a specific date by clicking the View Date button. 
 

 
Figure 18:  Calendar Views 
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The small calendar on the left allows you to 
switch to a different month or to drag across the 
date range that you would like to view. 
 

 
 
 
 
 

Figure 19: Selecting Calendar Month 

QuickTime™ and a
TIFF (LZW) decompressor

are needed to see this picture.

Creating an Event or Appointment 
 

Entourage allows you to create events on your calendar that last all day or for a 
specific duration. These events can occur just once or appear as recurring events. You can 
even send an invitation to an event to other users on the Exchange server to set up 
meetings. 
 

1. Click Calendar.   
2. Click New.   
3. In the Subject box, type the name of the event.   
4. Type in a location in the Location box.   
5. Enter the start and end dates and times.   
6. Select any other options you want.   

 

 
Figure 20:  Creating An Event or Appointment in Entourage 
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You can also create a new event by double-clicking the date and time of the event in 
Day, Work Week, Week, and Month views. You can set a reminder for an event that 
Entourage will display before the event start time. The default reminder time is 15 
minutes before the event start. 
 

Recurring Events   
 

You can tell Entourage to schedule a recurring event while creating your appointment 
or event.  Events can recur daily, weekly, monthly, or a specified number of days apart. 
 

1. When scheduling an event, choose a frequency from the Occurs dropdown list. 
 

 
Figure 21:  Selecting Event Recurrence 

 
2. Click the Edit button next to the frequency. 

 

 
Figure 22:  Editing Event Recurrence (Advanced) 
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3. Choose no end date, a set number of recurrences, or and end date for the event. 
4. Click OK. 

 

Setting up a Meeting   
 

You can schedule events that you want to invite others to, such as meetings.    
 

1. When creating an event, click the Invite button in the event toolbar.   
2. In the Invite box add contacts from your address list or, if you are on the 

Exchange server, select the Default Global Address list as your address book.  
 
 

 
Figure 23:  Inviting and Selecting Meeting Attendees 

 
When adding contacts from the Global Address list (labeled Default Global …) 

you will also be able to view their free and busy times. This will help you avoid 
scheduling events when critical attendees cannot be there.   
 
3. To do so, click on the Scheduling tab to view the schedules of the Exchange 

users. 
4. Click Send Now or Send Later (The send icon with the clock), as illustrated 

below. 
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Figure 24:  A View of the Scheduling Tab to Pick Ideal Meeting Time 
 
 
If you’re an Exchange user or if the recipient’s e-mail program supports Internet 

Calendaring (iCalendar), the recipient can use e-mail to accept, tentatively accept, or 
decline your invitation.  
 

Making a Private Appointment 
 

When editing a meeting or appointment from the calendar menu, you can 
designate the reserved time as private, i.e., the contents and identification of the event are 
not visible to other users.  Go to Event and select Private.   

Sharing Your Folders 
 
You can share your calendar, inbox, tasks or other Entourage folders.  
 

1. Select the navigation icon of the folder you would like to share, such as Calendar 
or Inbox.  (Normally, only calendars are shared, but sharing your Inbox is a way 

to have a group e-mail inbox be accessible to many people without having to 
share passwords, which is a nice thing to do.)   
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Figure 25:  Pick The Exchange Folder to Share from Entourage 

 
2. Select the Exchange Folder you want to share, be it contacts, mail, calendar, tasks, 

etc., as illustrated in Figure 25.   Then, go to Edit Folder Properties  
3. Then, set the permissions that you would like for your folder.  Existing 

permissions will already be visible.  If you change your Default permissions, you 
can make your selected folder visible to all Exchange subscribers. 

 

 
Figure 25:  Sharing Your Calendar With Others 
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Designating Delegates 
 

If you’re an Exchange user, you can specify another person as a delegate, so that 
they’ll be able to accept or decline meeting requests, or even read e-mail, on your behalf. 
Before you can access and manage another person's Exchange information, they must 
give you delegate access.  Delegate access can only be set up and managed by using 
Microsoft Outlook.  For instructions on assigning delegate access please reference the 
ITS document in the “Answers” section for Premium E-mail services called “Accessing 
Mailboxes if you are a Delegate (Mac),” at 
http://www.utexas.edu/its/messaging/answers/mac_delegate.php.  The document 
references delegate creation using the Outlook program.   
 

Please note that if you cannot see the free/busy information for a specific user, 
you might want to check delegate permissions with the calendar owner.  Additionally, 
this problem happens if Outlook or Entourage has never been set up on the Exchange 
server for the specific user you are trying to look at.   You will encounter this problem 
also if you selected the user’s e-mail address off of your local address book or contact list 
and not the Default Global Address List.  Otherwise, you might need to contact your 
Exchange system administrator to find out what the problem is. 

Viewing Someone Else’s Calendar 
 
Looking at someone else’s calendar one at a time, or viewing an Exchange server 
managed resource such as a room or a piece of equipment, is easy in Entourage.   
 

1. Select File->Open Other User’s Folder 
2. Enter in the name of the person whose folder you wish to see.  (Calendar is 

already selected as a default)   
 

 
Figure 26:  Viewing Someone Else’s Calendar 

 
3. Click OK.  If further information is needed, or you click on the Find User tab to 

the right of the User field, the search dialog will pop up, giving you a chance to 
pick the specific person’s calendar or resource to access. 
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4. Once you have selected a calendar, or a resource, Exchange determines if you 
have permission to access it.  If you do, the person’s calendar, or other folder, 
such as e-mail, will appear on your screen if you have permission to see it and a 
view for it will appear in the Calendar View.   
 

Using the same process, you can view room resources directly, and then schedule 
meetings in the same manner that you schedule any other appointment.  While editing an 
event, you can also go to the Events menu and Invite Attendees and mark the event as 
private.   Please note that you must have read/write access to this resource before you can 
schedule meetings for it yourself.  The resource owner must still approve the meeting.  
We recommend that you do not mark UT resource reservations as private since these 
cannot be rescinded even by the resource owner.  
 

You can also see resources from the Contacts folder in the folder list and also from 
the Address Book.  However, do not try to access resources from the Address book at this 
time since there appears to be a bug in that function when searching for non-people 
resources. 

Mail Rules 
 

You can set up rules in Entourage to sort your mail for you as it is received. You may 
want all mail from a certain sender to be delivered to a certain folder.  This feature can be 
used to store certain types of messages on your local machine to save server disk space. 
 

1. From the Tools menu choose Rules. 
2. Click the tab for the type of e-mail account you are using. In the case of Exchange 

server users, click on Mail (Exchange). (You must set up separate rules for each 
e-mail account you access through Entourage.) 
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Figure 27: Setting Up Mail Rules 

 
3. Click New in the Rules window. 
4. Name your rule and specify the criteria that a message should meet in order for 

the rule to be executed. 
5. In the Then section, specify what actions should be performed on the messages 

that meet the criteria. 
 

 
Figure 28:  Configuring Mail Rules 
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6. Click OK. 

 
On Microsoft’s site, there is more comprehensive information on creating rules.  

These documents can be found at: 
 
office.microsoft.com Office for Mac  Entourage 2004  Articles and Tips 
 

You should also use Rules to create out of office messages there since is no Out 
of Office Assistant for Entourage as exists with Outlook.  However, the Microsoft 
Office 2004 for Mac Resource Kit from Microsoft does address this issue.
 
 Remember, message rules do not run on the Exchange server as is the case with 
many rules configured through Outlook, but are client-side rules.  You will have to be 
running Entourage to apply rules.  To apply rules to your e-mails received before starting 
up Entourage, use Message Apply Rule. 

Emptying the Deleted Items Folder 
 

You can empty the Deleted Items folder manually or automatically.  To empty it 
manually, simply type CTRL-Click on the Deleted Items folder and it will be emptied.  
To delete the contents automatically, go to Run Schedule at Tools Run 
Schedule Empty Deleted Items Folder and set a schedule to clean out the Deleted 
Items folder.  You must select the Deleted Items folder on the server in order to ensure 
that deleted messages do not accumulate and fill up your disk quota; otherwise, only 
messages stored locally will be deleted. 

Creating and Restoring Message Archives 
 

Entourage has a built-in archiving capability.  Select File Export to activate the 
Export menu.   You can export Mail, Tasks, Local Contacts, Notes and Local Calendar 
events.   Note that you can archive items by category, such as all e-mail associated with a 
project. However, you cannot archive items by date.  You cannot export group 
information directly.   Then, click on Next.  After that, you have the choice to keep items 
in Entourage after they are archived.   
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Figure 29:  Exporting Message Archives 
 

You will then get a choice in which file to archive your Entourage content.   The 
default file extension is “rge”.  Please choose and appropriate filename to ensure proper 
identification and retrieval of the archive later. 
 

 
Figure 30: Saving Entourage Archives 

 
 

Restoring Entourage content requires going to File Import and loading the 
appropriate “rge” file. Here are a couple of tips from the UCSF information retrieving 
and examining Entourage archives: 

• If you need to refer to information stored in an archive temporarily. Create a new 
identity and import the information into it. Then, when you are finished, you can 
simply delete the new identity.  

• If you want to explore the contents of an archive, CONTROL+click the .rge folder 
and then click Show Package Contents.  
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